| update R&D WBS

Process: Costing Model Architecture

Responsibility area: Master data management

@ This document describes the transactions related to the process of R&D project modification.

The R&D projects aims to track costs of R&D projects. In order to facilitate the capitalization of qualifying
R&D projects, a time and cost-tracking system has been created using WBS (Work Breakdown
Structure) in the accounting ERP system (SAP).

Guideline

| receive the request to update a R&D WBS

STEP 1

If a request is received to change
project to Asset Under Construction
(AUC) you should go to CJ02, insert
the project code or WBS element

Enter «
code and

You will see all the WBS structure of
the project.

STEP 2

Change Project: Initial Screen Change
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Considering that is not possible to
change the WBS codification, and
also not possible to change existing
settlement, as you can see by the
color (is not white) of fields of first line,
you should create a new WBS, filling
the second line of screen above, with
the same codification, but ending with
letter C (as for capitalization).

This new WBS will be set up for
capitalization using type R2 and
settlement to AUC as described in the
current procedure. Keep the same
WBS element codification (with C at
the end), the same Description and
the same Short ID; insert “2” in
column “Level” and “R2” in column
“Typ”; and select the same options of
the first line in the columns “Su”, “PE”,
“Acct” and “Bill”

STEP 3

Then you should select the first line
and go to “Settlement Rule”

Settlement Rule

On the Maintain Settlement Rule:
Overview screen, you should change
the settlement parameters to WBS,
tracking the menu “Goto” and the
option “Settlement parameters”,
inserting the code “ZPS12” in the field
of the Settlement profile and the code
“BG” in the field of the Allocation
structure.

STEP 4

# .| Change Project: WBS Element Overview
& &2 % ] T Summarzation

Proj. def. [R-DOSATXGES X085 Product development for DS40/640

B5cData | Dates | Assgnments | Responsbities |/ Control | Total

5. Level WBS element
1 RUDSAUX0SS
RUOSAUX08SC

Description
X085 Kabx D540/640 - Next gen 2955
X085 Kalx D540/640 - Next gen 2055
1
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@ Change Documents
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Other rules...
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X085 Ki
Actual settlement Views
Back
Distribution rules
intain Settl Rule:
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WBS element R-UQSAUX0ES
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Description
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PA transfer str-
Source structure
Asset Value Date
Hierarchy number

R&D - WBS->WBS (CE original)
R&D - WBS->WBS (CE 9370000000)

Strategy Sequence
Entered by PT63016524 lon 22.10.2015
Last changed by PT63022051 on 08.03.2016
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Then you should click on “Back (F3)”

; insert the last period and the
current year in the columns “To
Period” and “To Fiscal Year” of first
line, relative to old settlement receiver;
insert “WBS” in the column “Cat”, the
code of changed project ending with
letter C in the column “Settlement
Receiver”, and the current period and
the current year in the columns “To
Period” and “To Fiscal Year” of
second line, as shown bi the screen
bellow; and press m two
times.

You will see in your screen the
following message

And you should click on
continue.

STEP 5

Then you should deselect the first line
and select the second line

STEP 6

You should go to settlement rule
Settlement Rule and

change the settlement parameters to
AUC, on the menu “Goto”, “Settlement
parameters”, and insert the code
“ZPS11” in the field of Settlement
profile and the code “BF” in the field of
Allocation structure

Finally, you should click on e twic

e and save by clicking on

STEP 7

If you go to CJO3 (display mode), and
insert the code of changed project you
can verify the new System status in
the column with same name as “REL
AUC".

STEP 1

If a request is received to change a
project to Fixed Asset

Go to CJ02 and select the project
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Allocation structure BF|
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Source structure
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Strategy Sequence

R&D - WBS->AUC (CE 7211000000)
R&D - WBS->AUC (CE 7210000000)
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Last changed by

PT63022051 |on
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08.03.2016
08.03.2016
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STEP 2

Select the WBS/Line where you want
to create as final assets: Extras ->
Create completed Asset

STEP 3

Go to the next screen and complete
the missing information provided in

the request: Asset Class and Cost
center.

In the bottom of the SAP screen the
following message will appear:

STEP 4

Go the settlement rule of the WBS to
confirm you have a new line for the
final asset.

STEP 5

Then go back e to the previous
screen, in order to set up the project

as Technically completed: Edit -> Stat

us -> Technically complete.

Change Project: Initial Screen
H F

—
Project Def. R-TOSALXO26
WBS Element
[& poject Edt Goto WBSelement Detais [ Extras | System Help
@ -4 @@ | Projecsimmezton r8
Create document
Change Project: WBS Element  Deprecaton simubtion data
B e — Asset under construction  Ctri+Shift+F2
Greate completed asset
Proj. def.  |R-UOSALX026 X026 P Investment program Curlshift+FL
Settings
BascData | Dates | Assgnments | Responsbilties | Control | Total
S.. L.w. \WBS element Descrigtion Short D v
| 1 Ruosax2s X026 PPA for AutoJEE (AE4133) P 2

[E Create Asset:

Asset(s) to be created

Asset Class EZUSE4000
Company code [ asset 5782
Number of similar assets 1
["1Subnumber

Reference

Company code [ asset

Master data

Description X026 PPA for Auto/EE (AE-4133)

Inventory number
Business Area 3100

Cost Center HD37000010
Plant I3
Location

Additional data

1 assets created internally, and distribution rules created

WBS element R-U05ALX026
X026 PPA for Auto/EE (AE4133)
Actual settlement

Defautc distribution rules

Cat |Settlement Receiver  Receiver Short Text (% | Equivalence no. Se... No. S... Fro... From... To .. ToFi.. [Fisst Used Last Used

FXA 150000003370-0 X026 PPA for Auto/EE (.. 100,00 0 auc 1 o o
FXa  INTERM00001-0 X026 PPA for Auto/EE ( 1 o2 |

003.2013 005. 2013



STEP 6

Check if the status in WBS is "TECO".

STEP 7

The project can now be saved

Then, display again the project and
settlement rule, in order to find the
final asset number as below ( eg:
250000024135-0).

=g Project | Edit | Goto WBS element  Details Extras  System  Help
g sglect '@ CSHE DDhOa8n
Object >
C  Sstatus » Release
Project wersion Shift+F4 Lock
g
View » Unlock
Proj. def. Cancel F12 Order accepted _
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1 User Status vl
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|1 RUosAX026 aM-6a8 R2 [ 4 [ [ TEco auc serc
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X026 PPA for Auto/EE (AE-4133)
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Cat |Settlement Receiver |Receiver Short Text L Equivalence no. Se... Mo. S... F
FXA 150000003370-0 X026 PPA for Auto/EE (.. 100,00 0 Uc 1 ]

FEA 250000024135-0 X026 PPA for AutofEE (..

1 FUL

Then, you must go to the transaction AS02, to change the Master Data of the Asset created.

STEP 8

Insert the Asset code and press Enter

Change Asset: Initial screen

Master data  Depreciation areas  Asset values
Asset 250000020490 (3
Subnumber 0
Company Code 5835

STEP 9

In the tab “Allocations”, you must insert the
code “E1” on the field “Evaluation group 4"

2



@ .| Change Asset: Master data

H B Assetvalues

Assot |2sooooozoas0] o | AB70 Surfactants consumption reduction
Class [zzTE1510] COSTI DI RICERCA Company Code | 5235/

General | Time-dependent ./ Allocations | Origin | Net worth tax | Insurance | Deprec. areas

| Allocations
Evaluation group 1 [}
Evaluation group 2 [ ]
Evaluation group 3 A
Evaluation group 4 | E1 | IDENTIFIABLE INTANGIBLE ASSETS
Evaluation group 5 "]

STEP 10

In the tab “Deprec. areas”, just verify if the
uselife of the asset is according to the
details of the request.

[® . Change Asset: Master data

B @ assetvales

e e—

Asset 250000020490/ |0 A670 Surfactants consumption reduction
Class [z1TE1510] COSTI DI RICERCA Company Code  |5835]
General L Tme-dcgendmt .&aﬁans ¢ Origin ; Met worth tax ; Insurance é@
ﬁ’. i
Vakiation [
A..|Depreciation area |DKey IffiseLie rd ODep Start  Index i
01fiscale 20 | O 5| 01.04.2016 =
02 civilstica 0000 | | 01.04.2016 =
16CAP+123456R, 0000 | 5 | 01.04.2016
20rival.1983 0000 | 01.04.2016
21rval.1991 0000 | 01.04.2016
22rval. 2003 0000 01.04.2016
25Affrancament 0000 01.04.2016
28 finanziament 0000 01.04.2016
30finanzament 0000 | | 01.04.2016
35ex01-fiscale ITBil‘ 5 ‘I 01.01.2016
32 IRAP tax 2201 | s | 01.04.2016
33Fscal IRAP 2201 \ s 01.04.2016
S0gestionale Zz01 \ 5/ 01.04.2016
T0assicurazion o000 | / 01.04.2016
80copa 01 cv 2201 "-,‘ k 01.04.2016
STEP 11

Finaly, you must run the settlement of the
Project or the WBS element, in order to start
the depreciation of the Asset created, by the
transaction CJ88.

Insert the WBS element code on
corresponding field, insert the period of the
start of capitalization on Settlement period
field, insert the current fiscal year, and
select the Processing type “Full Settlement”,
as shown on screen below.

Press Execute @ .



Actual Settlement: Project/WBS Element/Network

@
—_—
Project
or
WBS Element R-U0SBL132¢| (u]
or
| |
Network
[CJwith hierarchy

[CIWith orders

Settlement period 4 Posting period

Fiscal Year 2016 Asset Value Date
. I ETTrr—r——

Processing type Full Settlement -

Processing Options
[V Test Run

ot

[ Check trans. data

STEP 12

The last stage, is verify if the settled amount
corresponds to the total of R&D project
expenditures, by clicking on the Detail lists

, and you will see one screen like the

following one.
" Actual Settiement: Project/ WBS Element/Network Basic list

| @O
Selection
Selection parameters vake tame
WeS Bement RUOSELI28. A670 Surfactants consumption redu,,
Period 003
Postng pered 03
Facal Vear 2016
Processng tyve 8 Ful Settiement
Postng Date 31032016
Controling Area e %P SOLVAY
Cureney
Vae date 31032016
Processing Options
Selection Parameters Vale
Executon type ‘Seuement executed 5
Processng mode Tesun =
[[rocesing compieted wh oo arors
Statistics
Processng category T Humber
‘Satslgment exscviad 1
Mo change
ot reloans
Inagproprate siatus -
Emu -

Actual Settlement: Project/WBS Element/Network Detail list
pasic kst B | O sender Recewer [B] settementue [ A F B % & Msave [Bseea

Detail list - Settled values

Senders Receiers Short: text: Sender I ValiCOdrea Croy COArCur T Value in Obj. Croy | Ob.Cr/Send
WES R-U0SBL1328 XA SE35(250000020443/0 AG70 Surfactants consumption reduction 158.002,52 EUR 158.012,92 EUR

. 158.012,92 EUR " 158.012,92 EUR

STEP 1

Go to CJO2.

Enter the project.



Change Project: Initial Screen
AT

Project Def. R-UOSAUX024 7
WBS Element
Rule:
STEP 2 W4 » M &DOE G & Ponsetlement
WES element Detals_(F2)7
. . X024 High Heat PPA

Select the project and click on Actualsettiement

“Settlement rule”
Distribution rules
Cat  Settiement Receiver Receiver Short Text % Equivalence no. Amount A. Se... No. §S...

Seﬁlemnt Ruh CIR NDF10RDOOA (FIAL-AMODEL - AIS 100,00 BER 1

Click twice on the line of the
Settlement rule or click on “Details”.

Maintain Settlement Rule: Distribution Rules

STEP 3 S 2

o T

a
| Settlement Sender
WBS element |R-vosAUK024
X024 High Heat PPA
Company Code [5978!
Actual settlement

Change the “Valid to” period.

Settlement Receiver
Cost Center NDF10RDOOA| FINAL-AMODEL -A.
Order

| Distribution Rule |
Nurmber 1] vald from o B Em
Settlement type | FER
Percent 100,003
Equivalence no.
Amount in  EUR Amt rule type || settie Each Period
Strategy ]

[ settementrule Edt [ Goto | System Help

STEP 4 ] Change Documents Onof BE @
Details F2
] Maintain Se
Go back to the previous screen and H4rna@ng "
click on “Go to” and “Settlement T Qther ks
» WBS element R-UOSA Settlement parameters F8
parameters”. et
Actual settlement Views »
Back F3
Distribution rules
Cat  Settlement Receiver Recever Short Text % Equivalence no. Amount A..Se...
CIR ETIORDEOA FINAL-AMODEL - AIS 100,00 PER
|
STEP 5

Change the “Settlement profile” to ZPS
12 and “Allocation structure” to BG.



Maintain Settlement Rule: Parameters

2
WBS element [r-vosauxo024
X024 High Heat PPA
| Parameters
Description
Settlement profie ZPS12 R&D - WBS->WBS (CE original)
Alocation structure [56] R&D - WBS->WBS (CE 9370000000)
PA transfer str. ]

Source structure
Asset Value Date
Hierarchy number
Strategy Sequence

Entered by FT400066 on 24.09.2013
Last changed by |Brs0069 lon [21.03.2014

Maintain Settlement Rule: Overview
M 4 » M & ORE &b da Phnsettlement

'ﬁNew rule (F9)

STEP 6

Go back to the previous screen and

click on “New rule”. et

X024 High Heat PPA
Actual settlement

Distribution rules
Cat  Settlement Receiver Receiver Short Text % Equiva
CTR NDF10RDOOA FINAL-AMODEL - AIS 100,00
[m]

Maintain Settlement Rule: Distribution Rules
STEP 7 - A L]

Inform the new WBS element and the Settlement Sender

(o . ” WBS element R-UOSAUX024
Valid from” as below. AT
. Company Code [s978]
Go back to the previous screen and e et
i

save it =1 Settlement Receiver

WBS Element R-UOSALX024 O
| Distribution Rule
Number 2 Valid from 3 [2014/to
Settlement type  |PER
Percent [100,00]%
Equivalence no.
Amountin EWR | | Amtrletye | | settle Each Period
Strategy ]
Change Project: Initial Screen

STEP 1

To update the settlement rule of & E
project to cost center, go to CJ02 and
insert the code of project.

Project Def. R-U0SAUX024 7
WBS Element




STEP 2

Select the line related to project and

Settlement Rule

click on

STEP 3

Click on “New rule (F9)” and
change the field “Valid to” to previous
period.

STEP 4

Go back to the previous screen and
click on the menu “Goto”, “Settlement
parameters”, and insert the code
“ZPS10” in the field of Settlement
profile and the code “BE” in the field of
Allocation structure

STEP 5

Change the “Settlement profile” to ZPS
10 and “Allocation structure” to BE.

STEP 6

Cat  Settlement Receiver
WBS  R-U0sALX024

(@ .| Change Project: WBS Element Overview
& &b & % = T summargation

Proj. def.  [R-UOSAUR028 X024 High Heat PPA
BascData | Dates | Assgnments | Responsbies | Control | Total
S..L... \WBS element Description

1 RUOSAUX024 X024 High Heat PPA

N

.2} Rute:

Mo > o & DB gD & pon settiement
WES element R-UOSAUTX024

X024 High Heat PPA

Actual settiement

Distribution rules

Receiver Short Text %
X024 High Heat PPA 100,00

Amount.

Maintain Settlement Rule: Distribution Rules

Short 1D
238

Tve Pi Su

R -
R

Equivalence no. A.Se...
PER

PE
v

No.
1

A
Settlement Sender
WBS element R-UOSAUX024
X024 High Heat PPA
Company Code (5978
Actual settlement
Settlement Receiver
WBS Element R-UOSALX024
Distribution Rule
Number L] valid from [3 [2014]t0 (5 |2014]
settlement type |Ez&|
Percent m %
Equivalence no.
Amountin EUR Amt rule type Settle Each Period
Strategy

[& settlementrule  Edit | Goto | System Help

e | Change Documents 3 o[ oo
Details F2
Maintain Se 1o -
M4 rm@&@0OE -
L Other rules...
WBS element R-UOSH Settlement parameters F8
X024 H Overvie
Actual settlement Views »
Back F3
Distribution rules
Cat  Settlement Receiver Receiver Short Text % Amount
WBS R-UOSALX024 X024 High Heat PPA 100, 00

A313 H2TRUST-FP7 N.325357

Parameters
Description [
Settlement profile ZPS10 | R&D - WBS -> CHEOPS CCtr
Allocation structure ze] R&D - WBS->CHEOPS CCtr
PA transfer str. []
=
Source structure
Asset Value Date
Hierarchy number 0
| o |

Strategy Sequence



Go back to the previous screen and

click on “New rule (F9)”
the menu Edit, New rule.

orgoto

STEP 7

Inform the new Cost center and the “V
alid from” to the period the project
should start being settled using the
new settlement rule.

Number: New settlement rule number
(sequencial).

Settlement type: PER

Percent: if 100% or less

STEP 8

Go back to the previous and now, you
should find the two settlement rules

Go back e to the previous screen

and save it

STEP 1

To update the settlement rule of
project to order, go to CJO2 and insert
the code of project.

STEP 2

Select the line related to project and

. Settlement Rule
click on .

LS setuement rule | Egit | LOTO  bystem  Help
[V lewnke P @@ DHE PDOD
Delete rule
Mainta Gneel  F12  le: Overview

M4 » M @& DO Eah & Phnsettlement

R-U05AUX024
X024 High Heat PPA

'WBS element

Actual settlement

Distribution rules
Cat Settlement Receiver Receiver Short Text %
W8S (JvosaLxo24 X024 High Heat PPA

Maintain Settlement Rule: Distribution Rules
A &b da
Settlement Sender
WBS element R-U0SAUX024

X024 High Heat PPA
Company Code 5978
Actual settlement

Settlement Receiver

100,00

Cost Center NDF10RBEOA|

Oider

Distribution Rule

Number 2 Vald from 6 |2014|to

Settlement type  |per

Darcent Tiod Js

Equivalence Tic:

Amountin EUR Amt rule type Settle Each Period
Strategy ]

‘® .| Maintain Settlement Rule: Overview
H € M EDGE s & puosettiement

WES dorment

Revosmioze
X024 High Heat PPA
Actualsattlement.

mh::‘:n:-:mw Recewer Short Text % Amount

e P b =
Change Project: Initial Screen
AT

Project Def. 'R-UO5AUX024

WBS Element '

Change Project: WBS Element Overview
& E ™ T summaaton
Proj. def.

R-U0SAUX024 X024 High Heat PPA

_ABascData | Dates  Assgnments | Responsbies | Control | Total
S.. L... WBS element

71 1 ruosauxozs
1

Short ID
ne-g3e

Desarption
X024 High Heat PRA

g

2014 s
2018

T PiSu
RL n

Equivalence no.

Equvaence no. A. Se... Ho. S... From Peri... From... To ... To f.

2014

PE
=



[® .| Maintain Settlement Rule: Overview
STEP 3 M4 » M & D &b &L plan sectlement

WES element R-UOSAUX024
X024 High Heat PPA

Then you should click on “New rule

Actual settlement

Distrbution rules
(F9)” , or click twice on the line |Cat  Settiement Recewer Recewer Short Test %  Amount Equivalence no. A..Se... No.
of the settlement rule ves_R-vosaLKozs X028 Hgh Heat PPA 200,00 —

and change the field “Valid to” to Maintain Settlement Rule: Distribution Rules

previous period, as ilustrated. 2

Settiement Sender
WBS element R-UOSAUX024
X024 High Heat PPA
Company Code 5978
Actual settiement

Settlement Receiver
WBS Element [r-vosALx024

Distribution Rule

Number 1 Valid from [z J2012]t0  ([5 |[2014]

Settlement type |2k

Percent 100,00(%

Equivalence no.

Amount in EUR ] Amt rule type [] Settle Each Period
Strategy ]

[ settlementrule  Edit | Goto | System Help

STEP 4 [ Change Documents ' omog
Detais F2
Go back to the previous screen and Maintain Se 110t -
click on “Go to” and “Settlement Preyious rule
parameters”. £ HN4r»HEDER C_)thierru\es...
WBS element [r-v05A Settlement parameters F8
X024 H Overview
Actual settlement Views »
Back F3
Distribution rules
Cat | Settlement Receiver Receiver Short Text % Amount
WBS R-U0SALX024 X024 High Heat PPA 100,00
STEP 5 | Parameters
Description |
Change“the “Sgttlement pro’file” to ZPS Settlement profle 8510 | RRD - WEBS -> CHEOPS CCtr
10 and “Allocation structure” to AP. Alocation structure | e
PA transfer str. ]
Source structure
Asset Value Date

Hierarchy number
Strategy Sequence

STEP 6

Go back to the previous screen and
click on “New rule”.



STEP 7

Inform the new Cost center and the “V
alid from” to the period the project
should start being settled using the
new settlement rule.

Number: New settlement rule number
(sequencial).

Settlement type: PER

Percent: if 100% or less

STEP 8
Go back to the previous and now,

you should find the two settlement
rules

STEP 9

Go back e to the previous screen
|

and save it

If the below message appears

Delete the old settlement rule, by

clicking on “Delete rule”

Then go back e to the previous

screen and save it

L= Settlement rule | Edt | Goto  System  Help

@ lewnle P @@ CHE DDOO
Delete rule

Mainta cancel  F12  le: Overview
K 4 » M & O &b &5 Phn settlement

R-UOSAUX024
X024 High Heat PPA

'WBS element

Actual settlement

Distribution rules
Cat |Settlement Receiver Receiver Short Text % Equivalence no.
WBS| [(Phosarxo2d X024 High Heat PPA 100,00

Maintain Settlement Rule: Distribution Rules
2 &

Settlement Sender
WBS element R-U0SAUX024
X024 High Heat PPA
Company Code [5978]
Actual settiement
Settlement Receiver
Cost Center ]
Order 07026PRO5672
Distribution Rule
Number 2] Vaid from 6 (20140 )
Settlement ype  |pex]
Percent 100 A
Equivalence no.
Amountin EUR Amt rule type Settle Each Period
Strategy 1

(% .| Maintain Settlement Rule: Overview
H4 P&

WES dorment  [R-D0SATR024
X024 High Heat PPA
Actual setiement

Dsbutin res
Cot | Settiement Receiver ReceverShort Text % | Amount Ecuaknce no. A.[Se... Ho.[S... From Peri.. From... To ... ToFu. |
Jms Obosarxozs X024 Hoh Heat PPA 120,00 w13 200 s 20w
0% 07086mABS672 FAESOLVIN 5672 100,00 w6 2014

Typ|Message text LIxt

W@ |Receiver categ. WBS is not allowed by settlement prof. ZBS10 for this-|(®)

Maintain €cttlement Rule: Overview
M 4« » M & (& ub 55 Plnsettlement

R-UOSAUX024
X024 High Heat PPA

WBS element

Actual settlement

Send an e-mail to the Controller confirming that the R&D WBS was updated.



Workflow history

This view shows the 5 most recent entries. The complete workflow log is available from the ‘Document Activity' menu item.

Dec 03, Actor
2025

Published CHANSRI, Surachet

CHANSRI, Surachet

Sept 08, 2025

TORNPETCH, Ubonrat

Mar 12, 2025

Published
Gomes, Susana

Gomes, Susana
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State

State

Edit

State

Edit

State

Activity

changed state to Published at 6:25 am

gave Approvers approval at 6:25 am

updated the page at 11:24 am

changed state to at 9:24 am

updated the page at 2:59 pm

changed state to Published at 2:00 pm

Version
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